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About This Release 
This document describes the enhancements, fixes, and system requirements for GeoMedia. 

This release includes both enhancements and fixes. For information on new features, see the New 
Technology section. For information on fixes that were made for this release, see the Issues Resolved 
section. For information on hardware and software requirements, see the System Requirements section. 

This document is only an overview and does not provide all the details about the product's capabilities. See 
the product description, the online help and other documents provided with GeoMedia for more information. 

 

GeoMedia Desktop Product Tiers 
GeoMedia® is a flexible and dynamic GIS package for creating, updating, managing and analyzing your 
valuable geospatial information. Generate and update vector layers. Perform dynamic spatial analysis and 
generate reports. Automatically create and update maps. Manage data and map production more efficiently.  
GeoMedia is available in three product tiers, Essentials, Advantage, and Professional. 

GeoMedia Essentials enables you to query and analyse a wide variety of geospatial data sources. It also 
includes ERDAS IMAGINE Essentials, giving you the ability to do simple image preparation. 

GeoMedia Advantage has all the functionality of GeoMedia Essentials and is excellent for data collection and 
editing, processing and analyzing elevation and terrain data including LiDAR. It also includes data validation 
and sophisticated raster analysis tools. 

GeoMedia Professional includes all of the features of the previous tiers and provides enterprise-wide, multi-
user data management and analysis. Manage linear networks, produce professional cartographic maps, 
conduct advanced feature editing, manage parcel holdings, conduct utility network analysis, monitor and 
control changes, integrate data from multiple sources, and assure overall data quality with GeoMedia 
Professional. 

 

New Platforms – 16.6 Update 1 

Oracle 

Oracle 19c is now supported. 

PostGIS 

PostGIS 3.0 / PostgreSQL 12.1 is now supported. 

 

New Platforms – 16.6 Update 2 

https://bynder.hexagon.com/m/722a49b1be53661e/original/Hexagon_GSP_GeoMedia_Product_description_2022.pdf
https://hexagongeospatial.fluidtopics.net/search/all?filters=HGD_Product~%2522GeoMedia%2522&content-lang=en-US
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SQL Server 

SQL Server 2019 is now supported. 

 

New Platforms – 16.6 Update 3 

G/Technology 

The unified auditing capability of Oracle is now supported by the G/Technology data server. 

 

New Platforms – 16.7 

PostGIS 

PostGIS 3.1 / PostgreSQL 13 is now supported. 

CAD 

MicroStation CONNECT design files are confirmed to be compatible with GeoMedia. 

 

Impacts – 16.7 

Coordinate Systems 

When creating a Coordinate System definition from scratch, the default vertical datum is now “User-defined 
(non-standard)” rather than EGM96, so that later use of the Coordinate System, especially for a 2D 
coordinate system definition, is not mistakenly compromised by declaration of an incorrect vertical datum. 

Oracle 

Version 11.2.0.4 is no longer supported by Oracle, and therefore is no longer supported for GeoMedia. 

PostGIS 

PostgreSQL 9.3 with PostGIS 2.1 is no longer supported by The PostgreSQL Global Development Group, 
and therefore is no longer supported for GeoMedia. 

PostgreSQL 9.4 with PostGIS 2.2 is no longer supported by The PostgreSQL Global Development Group, 
and therefore is no longer supported for GeoMedia. 

Export to SQL Server 

This command and service no longer provide the ability to export to SQL Server 2008 Spatial format, as this 
version of SQL Server has been deprecated by both Microsoft and GeoMedia. 
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Schema Remodeler 

This utility no longer provides the ability to export to SQL Server 2008 Spatial format, as this version of SQL 
Server has been deprecated by both Microsoft and GeoMedia. 

 

Impacts – Future 

Feature Caching 

PublishIFC utility 

Since the introduction of PublishIFC.exe utility and its companion DataSourceMonikerCreator.exe, IFC 
publishing has been supported through two avenues – data servers and feature accessors. In the future, the 
feature accessor mechanism will be deprecated, and only data servers supported. It is recommended even 
with GeoMedia 16.5 that all publishing of IFC files be done via data servers. 

 

New Technology – 16.6 Update 1 

General 

Drag-and-drop 

Data that has been attached to a GeoWorkspace via drag-and-drop can now be accessed and used in 
scores of commands throughout the GeoMedia product line.  In most places where a treeview of feature 
classes and queries is presented for selection, look for a new Attached Data branch. 

Online Support command 

This command now goes to a GeoMedia-specific landing page for all kinds of online support activities such 
as discussions, training, support, and documentation. 

 

Data Access 

Oracle Object Model data server 

This data server now supports long identifiers (names of tables, columns, indexes, etc.) when working with 
Oracle database versions 12.2 and higher.  For more information see the help topics “GeoMedia’s GDOSYS 
Metadata Schema” and “Using Database Utilities with the Oracle Spatial Object Model”. 

Oracle Object LTT data server 

This data server now supports long identifiers (names of tables, columns, indexes, etc.) when working with 
Oracle database versions 12.2 and higher.  For more information see the help topics “GeoMedia’s GDOSYS 
Metadata Schema”, “Using Database Utilities with the Oracle Spatial Object Model”, and “Overview of the 
Transaction Administrator Utility”. 
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PostGIS data server 

This data server has improved interpretation of the “numeric” field type, ensuring more precise mapping to 
GeoMedia data types including integer types. 

This data server now supports connection via a PostgreSQL service name.  The connection syntax for the 
data server has been extended, and the user interface has an additional text field for entering the service 
name.  Depending on how the service is defined, the service name may be used alone or in conjunction with 
other connection parameters. 

Database Utilities 

This utility now supports connection to a PostGIS database via a PostgreSQL service name.  The user 
interface has an additional text field for entering the service name.  Depending on how the service is defined, 
the service name may be used alone or in conjunction with other connection parameters. 

This utility now supports the various Oracle TIMESTAMP data types (TIMESTAMP, TIMESTAMP WITH 
TIME ZONE, TIMESTAMP WITH LOCAL TIME ZONE), permitting them to be mapped to a Date attribute and 
subsequently to be served to GeoMedia.1 

Export to Oracle Object Model 

This command and service now support long identifiers (names of tables, columns, indexes, etc.) when 
working with Oracle database versions 12.2 and higher.  For more information see the help topics 
“GeoMedia’s GDOSYS Metadata Schema” and “Using Database Utilities with the Oracle Spatial Object 
Model”. 

 

Map Display 

SVG symbols 

Support for SVG symbols within style definitions has been extended to include additional characteristics in 
the ‘d’ attribute of a path element including: ‘v’, ‘V’, ‘c’, ‘C’, 's', 'S', 'h', ‘H’, 'q', 'Q', 't', 'T' 'l', 'L', 'm', 'M', 'a', 'A', 'z', 
'Z'.  This provides new capabilities for move to coordinate, straight line to coordinate, horizontal line, vertical 
line, return to start of path, cubic and quadratic Bezier curve, and oval. 

Additional improvements have also been made in support of rendering SVG files as symbols, including 
broader support for transformation including nested transformations, and broader support for styles including 
SVG styles, limited support of CSS styles, and style inheritance. 

SVG files may now be served in their entirety as symbols, rather than strictly treating them as symbol 
libraries containing named symbols.  When an SVG file is chosen for a Symbol style on the Style Properties 

 
1 It is important to note that Oracle TIMESTAMP columns may contain fractional second information. 
GeoMedia Date fields do not contain fractional second information. When TIMESTAMP columns are brought 
into GeoMedia these fractional seconds are not served. The values are displayed according to the format 
specified for that field without any fractional second information, and they participate in analytical operations 
without the fractional second information. If GeoMedia writes a Date value to a TIMESTAMP column it does 
not write any fractional second information, whether editing an existing value or performing output of that 
data value to another table or export format. If no edits are made to the Date column via GeoMedia then the 
original source TIMESTAMP value with any fractional second information will be unchanged. 
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dialog, if it has no embedded symbols then no symbols are listed for selection and the SVG file is treated as 
a symbol itself. 

 

Raster 

Images command 

This command now supports the ability to validate, delete, update, and display image features not only from 
feature classes, but also from queries and attached data. 

 

Framework 

Command enabling conditions 

A variety of commands now have their enabling conditions relaxed.  The following commands no longer 
require a warehouse connection to be present or open, so that they can be invoked using attached data as 
well as warehouse-resident data: 

• Select Set Properties 

• Geometry Information 

• Fit Selected 

• Display Selected Images 

• Select Text 

• Locate Feature 

• Run Spatial Model 
 

Data Window 

Sort Columns command 

A new command Sort Columns is provided on the Table ribbon tab.  This command can be used in 
conjunction with the existing Sort Ascending and Sort Descending commands, to sort the data window using  
multiple columns simultaneously.  It presents the current sort criteria for the data window and allows it to be 
altered using an ordered set of one or more columns, each of which can be sorted ascending or sorted 
descending. 

 

Explorer Window 

Attached data and queries may now be renamed.  Click on a selected node in the treeview to rename it. 

Attached data and queries may now be deleted.  Right-click on a node in the treeview and choose Delete. 
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Spatial Modeling 

Features Input operator 

When accessing feature data from a PostGIS data source, this operator now supports the serving of 
attributes with the data type “numeric”. 

When accessing feature data from an Oracle data source, this operator now supports the serving of 
attributes with any of the TIMESTAMP data types (TIMESTAMP, TIMESTAMP WITH TIME ZONE, 
TIMESTAMP WITH LOCAL TIME ZONE). 

 

Union Features operator 

The various “FeatureIn” ports on this operator now accept a List of Features as input, in addition to the 
singular Features data type that is already supported. 

 

 

New Technology – 16.6 Update 2 

Coordinate Systems 

Datum transformations 

New datum transformations have been added to autodt.ini that are pertinent to the region of Germany. 

 

Data Access 

SQL Server Spatial data server 

This data server now supports read-write data operations (insert, update, delete) on feature classes even in 
the absence of GeoMedia metadata.  In such a configuration the Refresh with Warehouse Changes 
command on the Manage Data tab of the ribbon is not able to refresh with the changes of other users due to 
the lack of GeoMedia modification logging tables in the database.  Other users’ changes may only be seen if 
a warehouse connection is reopened.  In this configuration the schema of the database remains read-only for 
GeoMedia. 

WFS data server 

This data server now offers a connection parameter that can be entered through the “Additional parameters” 
control on the Advanced Options dialog, that allows the user to designate that the geometry data returned by 
the service is to be treated as 3D rather than the default of 2D, even when the service fails to designate the 
SRSDimension attribute. 
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This data server now offers two optional behaviors controlled through checkboxes on the Advanced Options 
dialog, that can offer aid in case of issues with the WFS implementation.  These options are “Download 
feature classes and process locally”, and “Ignore schemas defined in GML”. 

This data server now serves only those attributes that were explicitly defined by the user, no longer serving 
system-level attributes defined as part of the GML infrastructure. 

 

New Technology – 16.7 

General 

File Dialogs 

The Windows dialogs used for file open, folder open, and file save actions have been enhanced to present 
the familiar modern explorer interface seen in Windows Explorer. The interface provides a navigation button 
and address bar, a command bar and search box, navigation pane with extensible favorite links, details pane 
that can be customized to show different views (from icons at various scales to various details), and a 
preview pane that can be optionally displayed. 

 

 

Drag-and-drop 

The capability provided with the 2020 release to drag-and-drop warehouse files and raster files into a map 
window or the Explorer window has been extended to permit drop into the legend of a map window.  This 
includes the ability to control precisely where within the legend the new legend entries are to be created. 
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High-DPI Monitors 

A manifest is now delivered that instructs Windows 10 to run GeoMedia using the high-DPI scaling override 
mode of “System” so that when running with Display Settings that scale the size of text, apps, and other 
items to greater than 100%, the system will automatically adjust to counteract certain negative effects of that 
scaling and GeoMedia will present better on high-resolution monitors. 

Coordinate Systems 

When creating a Coordinate System definition from scratch, the default vertical datum is now “User-defined 
(non-standard)” rather than EGM96, so that later use of the Coordinate System, especially for a 2D 
coordinate system definition, is not mistakenly compromised by declaration of an incorrect vertical datum. 

Coordinate Reference System (CRS) support for EPSG codes has now been updated from version 9.7 to 
version 9.8.15 of the EPSG Geodesy Dataset.  Support has been added for 85 new EPSG codes as well as 
a set of datum transformations related to new EPSG codes in Saudi Arabia. 

Support for Compound type EPSG CRS codes has been added to the existing support for Projected, 
Geographic 2D, and Geographic 3D types.  153 Compound CRS codes are now supported. 

When a CRS is defined via an EPSG code, that EPSG code is now retained as part of the CRS definition so 
that if the CRS is later output as an EPSG code, the originally-entered code is output.  New API is also 
provided for EPSG handling. 

Data Access 

ArcView data server 

This data server now supports CPG files that contain a code page indicator for the shapefile dataset.  With 
this improvement, it is no longer necessary to create a warehouse configuration (INI) file in order to specify 
the code page. 

PostGIS data server 

This data server now supports SSL connections to Azure-resident PostGIS databases. 

Oracle LTT data server 

The Commit command and the Discard commands associated with this data server now support the partial 
commit and discard of only deleted features.  It has previously been possible to commit/discard all changes, 
or selected changes.  However only newly-inserted or updated features can be selected, so it has not been 
possible to partially commit/discard only deleted features.  A new option for this purpose is now provided on 
each dialog – “Commit deleted features only” and “Discard deleted features only” respectively. 

In addition these commands now support the commit and discard of features in a query created by the Query 
Modified Features command. 
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The Query Modified Features command associated with this data server now provides greater control of the 
query content by allowing inserts, updates, and deletes to be separately chosen for inclusion.  Previously 
only deleted features could be either included or excluded, inserts and updates were always included. 
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GML, WFS, and WFS-T data servers 

These data servers now provide an option on the Advanced connection dialog to “Serve attributes of GML 
elements as additional GeoMedia attributes”.  This caters to a peculiarity of the INSPIRE implementation of 
WFS which deviates from typical WFS implementations. 
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Report Warehouse Schema command 

This command now allows nongraphic and coverage (raster) feature classes to be included in the report. 

 

This command also now offers a checkbox allowing the user to include in the report a count of the number of 
features in each feature class.  Use of this option may decrease performance. 

 

 

Picklists 

For application developers, public API is now provided for retrieving picklist information for an attribute 
GField of a GRecordset served through OriginatingPipe. 

• A new “Picklist” extension on the GField returns a Picklist interface that can return the set of valid values for the 
field, convert between a picklist value and description and vice versa, and more. 
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• A new “PicklistMetadata” extension on the GField returns a PicklistMetadata interface that can provide the full 
definition of the picklist including source connection, table, and fields. 

Picklist definitions for attributes are now conveyed through queries and categories and are therefore 
available for use throughout the product not solely when working with feature classes. 

Feature Class Definition command now offers an Assign Picklist button that invokes a dialog which allows an 
assignment of a picklist definition to be made to the attribute. 

 

 

Database Utilities also now offers an Assign Picklist button that invokes a dialog which allows an assignment 
of a picklist definition to be made to the attribute. 



GeoMedia Desktop 2020 

22 April 2022           19 

 

 

Three new expression functions related to picklists are now provided: 

• PicklistDescription returns the description for the current value of the picklist value field. 

• PicklistLookupDescription returns the description corresponding to a given value for the picklist value field. 

• PicklistLookupValue returns the value corresponding to a given description for the picklist value field. 

The Convert To AFM action of the Feature Model command now converts SFM-defined picklists into AFM-
defined picklists. 

Export to Oracle now exports the picklist definitions for those attributes being exported that have associated 
picklists. 

Export to SQL Server now exports the picklist definitions for those attributes being exported that have 
associated picklists. 

Output To Feature Classes now outputs the picklist definitions for those attributes being output that have 
associated picklists. 

 

Database Utilities 

For GeoPackage warehouses it is now possible to map the INTEGER attribute data type of SQLite to the 
Double data type in GeoMedia for cases in which the numeric values require storage greater than 4 bytes. 
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Framework 

Ribbon 

Several changes have been made to the ribbon bar in order to improve the visibility and accessibility of the 
most commonly-used commands, as well as to improve usability in other ways. 

• Add Legend Entries and Add Thematic Legend Entry have been promoted from their position on the Legends 
pulldown of the Legend panel of the Home tab, to being large buttons directly on the ribbon. 

• New Warehouse Connection and Warehouse Connections have been promoted from their position on the 
Warehouse pulldown of the Warehouses panel, to being large buttons directly on the ribbon.  The Warehouse 
pulldown is eliminated, with the remaining commands now directly on the ribbon as small buttons. 

• New Warehouse Connection and Warehouse Connections have also been added to a new Warehouses panel 
on the Home tab, for ease of access. 

• Spatial Filter and Spatial Filter Reference Features have been promoted from their position on the Spatial Filter 
pulldown of the Warehouses panel of the Manage Data tab, to being large buttons directly on the ribbon within a 
new Spatial Filters panel.  The Spatial Filters pulldown is eliminated. 

• The name of the Feature Class Definition command on the Feature Data panel of the Manage Data tab has 
been corrected from Features to Feature Classes. 

• The Spatial Filter toggle has also been added to the vertical set of small buttons in the middle of the Properties 
and Information panel of the Home tab, displacing the Review Attributes command on the bottom.  Review 
Attributes is moved into the middle of the vertical set of small buttons on the righthand edge of the panel, 
displacing the Select Set Properties command. 

• Select Set Properties is promoted to being a big button just to the left of the 3 commands above. 

• New Data Window, Show Layout Window, and New Map Window have been promoted from their position on 
the Add / Show Windows pulldown of the Window panel of the Home tab, to being small buttons directly on the 
ribbon.  The Add / Show Windows pulldown is eliminated, with Show Overview now directly on the ribbon as a 
small button. 

• Measure Angle has been demoted from its position as a big button in the Measure panel of the Home tab, to 
being in the pulldown list within the Measure panel along with the other measurement commands, so that 
additional space is made available on the Home tab for more commonly-used commands. 

• Delete Feature has been promoted from its position as a small button in the Feature panel of the Vector tab to 
being a full-size button, given the full title of Delete Feature, and placed to the immediate right of Insert Feature.  
Other small buttons have been rearranged within that panel. 

• Edit Geometry has been promoted from its position on the Edit pulldown of the Geometry panel of the Vector 
tab to being a large button directly on the ribbon in the leftmost position of this panel.  There it replaces the 
Delete Geometry pulldown which is removed, with its two commands Delete Geometry and Partial Delete being 
added to the Edit pulldown instead. 

• The Edit pulldown in the Geometry panel of the Vector tab is renamed to Edits, and its contents are reorganized 
on the basis of the above changes. 

• The Explorer panel is moved as-is from its current position on the Home tab to a new position between the 
Extent and Window panels. 

• Images is removed from the Feature Data panel of the Manage Data tab and added to the Raster tab, being 
inserted into the mix as part of a larger reorganization of the panels on that tab. 

• The Raster tab and its panels and commands are reorganized into 4 panels labelled Insert, Manage, Display, 
and Output. 
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Customize Ribbon command 

This command now offers the ability to add dropdown listbox control types (such as the Window List) to a 
custom ribbon. 

Explorer window 

This window now offers a Properties action on the context menu for spatial model results presented for each 
spatial model.  This action displays a dialog presenting the name and location of the IFC file or raster file 
containing the data. 

 

Running or rerunning a spatial model now causes that model to be executed using a 64-bit architecture. 

This window now offers a Rerun Asynchronously action on the context menu for spatial models.  This action 
can run on multiple selected spatial models. 
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This window now offers a progress bar and Cancel button for spatial model jobs that are running 
asynchronously.  This applies for spatial modeler jobs run asynchronously from the Run Spatial Model 
command, the Run action on the context menu for spatial models, and the Rerun Asynchronously action. 

 

This window now offers a modal dialog for progress reporting and cancellation when models are run 
synchronously through either the Run or Rerun actions on the context menu for spatial models. 

 

 

Map Window 

Mouse Wheel zoom and pan 

The ability to zoom in via mouse wheel forward rotation, zoom out via mouse wheel backward rotation, and 
pan via mouse wheel down-drag-release is now extended beyond the Select Tool command to most 
modeless commands in the product line.  Certain commands having an existing use of mouse wheel events 
in their functionality (e.g. Insert Text, Redigitize Text, Insert Interactive Label) retain their existing usage and 
do not support this. 

Legend Entry drag-and-drop 

The ability to drag one or more legend entries from the legend of one map window into the legend of another 
map window, is now provided.  Drag-and-drop can occur from and to both the Display Order and Groups 
tabs of the legend.  The legend entries are inserted into the active tab of the target legend at the drop point 
indicated by the cursor, and are inserted at the top of the inactive tab of the target legend. 

By default a copy of each dropped legend entry is inserted into the target legend.  If the Shift key is held 
down at the moment of drop, a move of each legend entry is performed instead. 

The pre-existing ability to drag-and-drop legend entries within a legend remains unchanged. 

Review Attributes command 

The Review Attributes command has been redesigned as a tool for reviewing the attributes of features 
associated with a legend entry.  You now select a legend entry on the dialog rather than a set of 
GeoWorkspace-resident features, eliminating any ambiguity surrounding which presentation of those 
features is being reviewed.  Now the expected attributes will be displayed regardless of whether the legend 
entry is presenting a feature class, a query, features from categories, etc. 
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When customizing the set of attributes to be displayed on the dialog, that customization is remembered and 
carried with the legend entry into named legends, libraries, and through drag-and-drop. 

You can use the space bar to toggle mouse tracking on and off, so that the cursor can be used on the dialog 
to resize, scroll, copy data to the clipboard, and customize attributes being displayed without changing the 
feature being reviewed. 

 

Data Capture 

The Measure Distance/Area and Measure Angle commands now support the Intersection, Tangent, and 
Perpendicular vector snaps. 

The Insert Dimension command now supports the Intersection and Perpendicular vector snaps. 

The Copy Feature and Copy Parallel commands now support the Intersection vector snap. 

Legends 

The Legends command no longer performs a Fit All when replacing the active legend of a map window. 

Style Definitions 

Styles dialog now offers an “Import from -> OGC SLD/SE Style Definition…” action on its right-click context 
menu, which permits import of a single style from an SE-structured XML file, or one or more styles from an 
SLD-structured XML file. 
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Raster 

External overviews are now supported.  GeoMedia has always checked for internal overviews for raster data 
when loading them for display. It now also recognizes external overviews in cases where internal overviews 
do not exist. Examples: 

• <basename>*.r1, *.r2, etc. (Overwatch, ERDAS convention, RSET (Replace Extension) option in the 
GenerateImagePyramid.gmdx spatial model) 

• <basename>*.r01, *.r02, etc. 

• <basename>.1, .2, etc. (LH Systems, ERDAS convention, Minifiles option in the C:\Program 
Files\Hexagon\GeoMedia Professional\Spatial Modeler\etc\models\GenerateImagePyramid.gmdx 
spatial model) 

• <basename>*.rv1, *.rv2, etc. (RemoteView convention) 

• <basename>.R0.ext (.tif, .ntf, or .tfd) (NIL files) 

• <basename.ext>.r1 (ERDAS convention, RSET (Append after Extension) option in the 
GenerateImagePyramid.gmdx spatial model) 

• <basename>.r1<.ext> (ERDAS convention, RSET (Insert before Extension) option in the 
GenerateImagePyramid.gmdx spatial model) 

• <basename>.rrd (ERDAS convention, RRD option in the GenerateImagePyramid.gmdx spatial 
model, GDAL supports) 

• <basename.ext>.pyrx (ERDAS convention, PYRX option in the GenerateImagePyramid.gmdx spatial 
model, .pyrx file is actually ECW format) 
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GeoTIFF tags within ECW v3 files are now read, interpreted, and used to georeference such files. 

Layout Window 

The Insert Object command now interacts with OLE in an improved manner, yielding better results especially 
on Windows 10 with Microsoft Office files for Word and Excel, with PDF files, and with JPG and other types 
of raster files.  Because this is a change in the behavior of the Insert Object command, the benefits are seen 
only when this command is used for new insertions.  Previously-inserted objects do not benefit, but of course 
those objects may be deleted and inserted again. 

The Convert To Graphics command for a legend now creates legend entry graphic keys using enhanced 
metafile (EMF) technology rather than metafile technology, with the result that those graphic keys presenting 
the legend entry symbology no longer disappear on Windows 10.  Because this is a change in the behavior 
of the Convert To Graphics command, the benefits are seen only when this command is used for new legend 
conversions.  Previously-converted legends do not benefit, but of course they may be deleted and inserted 
again. 

Functional Attributes 

The CONCATENATE function now allows ordering by a text field or expression. 

 

Spatial Modeling 

Run Spatial Model command 

The initial dialog of this command is now larger by default, and resizable. 

 

On the initial dialog the logic for generating the default output spatial model name is improved.  If the .gmdx 
file does not have an internal name then instead of defaulting to “Spatial Model”, the default is now the .gmdx 
filename without its path or extension. 

Upon OK on the initial dialog, the Model Parameters dialog is now displayed under all circumstances, even 
when there are no parameters defined for a model.  This ensures that the user is aware that the model lacks 
parameters, and it offers the chance to run the model asynchronously. 
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The Model Parameters dialog has several major usability improvements related to honouring the definitions 
of input parameters within the spatial model: 

• Input parameters flagged as optional in the spatial model are now presented as optional in the 
dialog. 

• Input parameters having default values defined in the spatial model are now presented with the 
default values in the dialog. 

• Input parameters having a defined set of allowable values defined in the spatial model are now 
presented with a pulldown list of those values. 

• When running a model that is parameterized to receive an input raster file, the command now 
remembers the last folder from which a raster file was selected during a GeoMedia session. 

The Model Parameters dialog now offers the opportunity to run the model asynchronously via a checkbox at 
the bottom of the dialog.  When run asynchronously, control is returned to GeoMedia while the spatial model 
runs independently.  Multiple models may be run asynchronously in this manner.  When a model is run 
asynchronously, its results are not automatically presented upon completion. 

 

Running a spatial model in GeoMedia now causes that model to be executed using a 64-bit architecture. 
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Progress reporting and cancellation capabilities are provided through the Explorer window while models are 
running asynchronously, and through a modal dialog while models are running synchronously. 

 

 

Features Input operator 

This operator now supports SSL connections to Azure-resident PostGIS databases. 

This operator no longer requires separate installation of “Microsoft System CLR Types for Microsoft® SQL 
Server” in order to access SQL Server databases. 

This operator now supports CPG files that contain a code page indicator for shapefile datasets.  With this 
improvement, shapefiles containing attribute data stored in code pages other than UTF-8 now have their 
attributes displayed correctly when the Show Attributes action is performed for layers in the Preview window 
of Spatial Model Editor. 

Features Database Output operator 

This operator now supports SSL connections to Azure-resident PostGIS databases. 

This operator no longer requires separate installation of “Microsoft System CLR Types for Microsoft® SQL 
Server” in order to output to SQL Server databases. 

Performance of this operator is improved, especially for larger datasets.  The degree of improvement will 
vary according to size and nature of the data as well as the configuration of the system, the database, and 
the network.  By way of example we have seen sample times such as: 

• Output to a GeoPackage database accelerated by 10-40 times. 

• Output to a SQL Server database accelerated by 2 times. 

• Output to an Oracle database accelerated by 2 times. 

Filter By Geometries operator 

This operator now provides an ExcludedFeatures output port that allows the model builder to access those 
features from FeaturesIn that did not satisfy the filtering conditions. 

 

This operator has also received some performance and memory usage improvements. 

Functional Attributes 

The following new expression functions are available for use in defining functional attributes for operators 
such as Generate Functional Attributes, Merge Features, and Summarize Related Features operators: 
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• LINES.  This expression function returns the boundaries of an area feature as linear features. 

• INTERIORPOINT.  This expression function returns the point most interior to the shape of the area (the center 
of the maximum inscribed circle). 

• ARCORIGIN.  This expression function returns the origin of the arc, i.e. the center of the circle upon which the 
arc is defined. 

• ARCRADIUS.  This expression function returns the radius of the arc, i.e. the distance from the center of the 
circle upon which the arc is defined, to the arc itself. 

• HASARC.  This expression function returns True if the geometry is an arc geometry, or is a composite geometry 
or geometry collection having at least one arc inside it.  Otherwise it returns False. 

• GEOMETRYTYPE.  This expression function returns an number representing the type of a given geometry (e.g. 
an arc geometry or a polyline geometry). 

• COMPONENTS.  This expression function expands composite geometries into their individual components. 

• SKELETON.  This expression function returns one or more polyline geometries representing the total collapse 
of an area to linework; or a mixture of polylines and area geometries representing a partial collapse of an area 
to linework and smaller areas. 

• MODE.  This expression function returns the most frequently occurring or repetitive value. 

• TRANSFORM.  This expression function performs the transformation of a geometry from its native CRS 
(coordinate reference system) to a target CRS. 

• CREATEPOINT.  This expression function creates an oriented point geometry from attributes containing 
coordinate values. 

New Operators 

The following new feature analysis operators are delivered with all tiers of GeoMedia Desktop: 

• Generate Topology Features.  This operator provides functionality analogous to the Generate Base Geometry 
command (and TopoGeometryPipe) of GeoMedia Desktop.  It also provides some functionality equivalent to the 
“Insert Area By Face” commands of GeoMedia Desktop. 

 

 
 

• Classify Features.  This operator classifies features by applying multiple attribute-based filters that assign them 
to corresponding classes. 

 

 
 

• Attribute Statistics.  This operator computes basic statistics for a numeric attribute, roughly equivalent to the 
“Column Statistics” command of GeoMedia Desktop. 
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The following new grid operators are delivered with the Advantage and Professional tiers of GeoMedia 
Desktop: 

• Calculate Flow Concentration.  This operator is part of a collection of operators for hydrological 

analysis.   It  predicts stream paths, with runoff being assumed to flow downhill from pixel to pixel. It provides 

functionality analogous to the GeoMedia Grid Flow Concentration command found under Surface commands. 

 

• Interpolate Using Kriging.  This operator provides an interpolation method that uses the spatial correlation of 
known data samples to determine the weights for estimating unknown data values. It utilizes an enhanced 
version of the 2D kriging module from the Geo-statistical Software Library (GSLIB), a set of algorithms and 
methods created by the Geo-statistical Research team at Stanford University. The GSLIB defines a modular 
approach to kriging that analyzes and prepares sample data to be interpolated into continuous data. The 
modeling requires substantial input from the user and requires the user to be very familiar with their data and 
with the practices of Geo-statistics. Interpolate Using Kriging performs the ordinary kriging process and relies on 
the user to set the property values to maximize the effectiveness of the interpolation. The Ordinary Kriging Suite 
command in the Grid component of GeoMedia Advantage/Professional, which implements the GSLIB approach, 
provides data analysis tools that can be used to determine these settings for a particular dataset. 

 
         Default      Show All Ports 

   

 

• Define Continuity Model Parameters.  This operator provides input to the Interpolate Using Kriging operator 
when the data to be kriged has anisotropic continuities that need to be defined or the data has a non-stationary 
mean. It defines a theoretical math model that best fits the semivariogram values of a sparse set of data 
samples in a specific direction of maximum continuity and produces a Dictionary that can be attached to 
Interpolate Using Kriging as input. Additionally, the Ordinary Kriging Suite command in the Grid component of 
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GeoMedia Advantage/Professional provides data analysis tools that can be used to determine these settings for 
a particular dataset. 
 

 

Sample Models 

Two of the delivered sample models, MergeByAttribute.gmdx and Aggregation.gmdx, are improved to 
support nongraphic feature classes. 

A new sample model AnalyzeGeometry.gmdx is delivered.  It provides functionality equivalent to the Analyze 
Geometry command of GeoMedia, and serves as another example of how to construct expressions for the 
Generate Functional Attributes operator. 

Spatial Model Editor 

The 64-bit version of Spatial Model Editor is now delivered and available from the Start menu. 

 

New Technology – 16.7 Update 1 

General 

Drag-and-drop 

When dropping a warehouse or raster file into a GeoWorkspace, the Options command setting to "Match 
GeoWorkspace and default Warehouse coordinate systems...when making first connection" is now honored 
so that the CRS of the GeoWorkspace no longer has to be manually overridden afterward to make it match 
the dropped data. 

Customized Ribbon definitions 

Exported custom ribbon definitions now include a universal command identifier, rather than a system-specific 
one, for commands that are installed by add-on applications.  This improves portability of customized ribbon 
definitions from one system to the next. 

 

Data Access 

Oracle data server 

This data server now supports read-write data operations (insert, update, delete) on feature classes even in 
the absence of GeoMedia metadata.  In such a configuration the Refresh with Warehouse Changes 
command on the Manage Data tab of the ribbon is not able to refresh with the changes of other users due to 
the lack of GeoMedia modification logging tables in the database.  Other users’ changes may only be seen if 
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a warehouse connection is reopened.  In this configuration the schema of the database remains read-only for 
GeoMedia. 

PostGIS data server 

This data server now supports read-write data operations (insert, update, delete) on feature classes even in 
the absence of GeoMedia metadata.  In such a configuration the Refresh with Warehouse Changes 
command on the Manage Data tab of the ribbon is not able to refresh with the changes of other users due to 
the lack of GeoMedia modification logging tables in the database.  Other users’ changes may only be seen if 
a warehouse connection is reopened.  In this configuration the schema of the database remains read-only for 
GeoMedia. 

GeoPackage data server 

This data server now supports read-write data operations (insert, update, delete) on feature classes even in 
the absence of GeoMedia metadata.  In such a configuration the Refresh with Warehouse Changes 
command on the Manage Data tab of the ribbon is not able to refresh with the changes of other users due to 
the lack of GeoMedia modification logging tables in the database.  Other users’ changes may only be seen if 
a warehouse connection is reopened.  In this configuration the schema of the database remains read-only for 
GeoMedia. 

ArcView data server 

This data server now supports the Coarse Overlap operator for spatial filtering.  Previously it would revert to 
the Overlap operator when Coarse Overlap was set as the active spatial filter operator for the 
GeoWorkspace.  With the Coarse Overlap operator the filtering process uses only the MBR of geometries, 
with the result that it returns results more quickly but those results may include features that do not precisely 
overlap the spatial filter geometry. 

KML data server 

This data server now supports the Coarse Overlap operator for spatial filtering.  Previously it would revert to 
the Overlap operator when Coarse Overlap was set as the active spatial filter operator for the 
GeoWorkspace.  With the Coarse Overlap operator the filtering process uses only the MBR of geometries, 
with the result that it returns results more quickly but those results may include features that do not precisely 
overlap the spatial filter geometry. 

MapInfo data server 

This data server now supports the Coarse Overlap operator for spatial filtering.  Previously it would revert to 
the Overlap operator when Coarse Overlap was set as the active spatial filter operator for the 
GeoWorkspace.  With the Coarse Overlap operator the filtering process uses only the MBR of geometries, 
with the result that it returns results more quickly but those results may include features that do not precisely 
overlap the spatial filter geometry. 

Publish to Map command 

This command now offers the option to publish KML with the Altitude Mode set to either Clamped or 
Absolute.  The default setting remains Clamped. 

 

Layout 
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Batch Plotting 

This utility now offers a checkbox to “Apply spatial filter dynamically” for the Sheet Selection workflow, just as 

it does for the Sheet Composition workflow.  Use of this checkbox causes additional processing to be done 

on a per-sheet basis, but it reduces the amount of data loaded for plotting and may improve scalability when 

batch plotting with large datasets.  
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System Requirements 

Computer / Processor Any x64-based processor 

Memory (RAM) 16 GB or more recommended 

Disk Space 

10 GB for software 

Data storage requirements vary by mapping project1  

Operating Systems2 

⚫ Windows® 10 (64-bit) 

⚫ Windows Server® 2016 (64-bit)2 

⚫ Windows Server® 2019 (64-bit)2 

Peripherals Software licensing requires an ethernet card 

Virtual Server and Virtual 
App Technology 

GeoMedia is a standard Windows application that has been shown to be compatible with a variety of 
virtualization technologies such as VMware, Hyper-V, VirtualBox, and XenApp.  While running 
GeoMedia in such environments is supported, any problems that uniquely occur in a virtualized 
environment are considered to be issues with the virtualization software. 

Database Servers6 

⚫ Oracle® Server 12.1 

⚫ Oracle® Server 12c (12.2.0.1) 

⚫ Oracle® Server 18c (12.2.0.2) 

⚫ Oracle® Server 19c (12.2.0.3) 

⚫ SQL Server® and SQL Server® Express 2012 

⚫ SQL Server® and SQL Server® Express 2014 

⚫ SQL Server® and SQL Server® Express 2016 

⚫ SQL Server® and SQL Server® Express 2017 

⚫ SQL Server® and SQL Server® Express 2019 

⚫ Azure SQL Database compatible with SQL Server® 2014, 2016, 2017, or 2019 

⚫ PostgreSQL 9.6 with compatible version of PostGIS 

⚫ PostgreSQL 10 with compatible version of PostGIS 

⚫ PostgreSQL 11 with compatible version of PostGIS 

⚫ PostgreSQL 12 with compatible version of PostGIS 

⚫ PostgreSQL 13 with compatible version of PostGIS 
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Database Clients6 

⚫ Oracle® Client 12.1, 32-bit3 and 64-bit4 

⚫ Oracle® Server 12c (12.2.0.1), 32-bit3 and 64-bit4 

⚫ Oracle® Server 18c (12.2.0.2), 32-bit3 and 64-bit4 

⚫ Oracle® Server 19c (12.2.0.3), 32-bit3 and 64-bit4 

⚫ SQL Server Native Client 10.0 or higher5 

 

System Requirements Notes 
1 Disk I/O is usually the slowest task in geospatial data processing. Faster hard disks improve productivity. 
Reading data from one disk, writing temporary data to a second disk, and writing data to a third disk 
improves performance. Disk arrays improve productivity, but some RAID options slow performance. Network 
disk drives are subject to network limitations. 

2 GeoMedia runs on 64-bit systems in 32-bit emulation mode. 

3 Oracle Data Access Components (ODAC) is required if using the Feature Accessor option for Oracle in the 
PublishIFC utility, or if using the Database Utilities utility to manage an Oracle warehouse. ODAC is normally 
delivered by the Oracle Client Administrator installer, but not by the Oracle InstantClient installer. ODAC 
contains many components, of which PublishIFC requires the Oracle Data Provider for .NET, and Database 
Utilities requires the Oracle Provider for OLEDB. 

4 GeoMedia requires Oracle 32-bit client software.  Oracle 64-bit client software is used only when 
connecting to Oracle using Spatial Model Editor. 

5 SQL Server Native Client 10.0 or higher is needed in order for the Database Utilities utility to automatically 
create the correct GeoMedia metadata for date, time, and datetime2 data types when using a SQL Server or 
SQL Server Spatial warehouse. You may get SQL Server Native Client 10.0 or higher from the 
corresponding Microsoft websites. If the SQL Server Native Client is not installed on the system, you need to 
manually choose Date as the data type from the dropdown combo box for these data types in the Feature 
Class Properties dialog and set the format properly. 

6 In all cases of database software, support for a specific version is dropped in the GeoMedia context when 
the database vendor ends support for that version. 
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Issues Resolved – 16.6 Update 1 
Support Ticket Description 

00052913 
The server name field is truncated in the New Warehouse Connection command for a PostGIS database with 
an AWS server name. 

00012067 
A coordinate system definition specified for AFM via the Feature Model command is not saved when 
GCoordSystem is empty. 

00046621 
00043393 
00040691 

The Select Set Properties dialog cannot be accessed on a single-monitor configuration if last positioned on an 
extended monitor. 

00053948 Setting an angle of “0” for the definition of a Dash Line Style results in an error. 

00006080 Database Utilities adds a space to the end of an assigned sequence number in Oracle. 

00008532 
00021310 
00023037 
00052277 

Attribute Query returns incorrect results when there is a very large integer number used in the SQL where 
clause. 

00039428 Tag Attribute values from MicroStation V8 design files are missing on Windows 10. 

00054319 
After changing the warehouse connection name, the Explorer window changes the order and names of 
connections. 

00002583 
00021042 
00008419 

The ArcView data server does not properly serve 3D shapefile geometries that have a null Z value. 

00046065 
00038521 

Coordinate system transformation from EPSG:6991 (Israel Datum) to EPSG:4326 (WGS84 Datum) produces 
an incorrect result. 

00031817  The PostGIS data server has incorrect logic when parsing a combined spatial filter and attribute filter. 

00020089 
When setting the coordinate systems projection to Krovak in the Define Coordinate System dialog, GeoMedia 
uses EPSG:5513 instead of EPSG:5514. 

00021095 
The Oracle data server generates errors when inserting metadata for Oracle tables containing field or table 
descriptions or comments that exceed 255 characters. 

00056458 
Drag-and-Drop of GeoPackage database with no GeoMedia metadata fails to add any feature class to the 
legend. 

00056337 
A read-write connection to a SQL Server database with no metadata results in errors from Select Set 
Properties or Display Data Window. 

00024575 An SVG symbol (1.1 version) with a path element fails to display. 

00020371 
00019594 
00002864  
00020156 
00038373 
00049140 

The X (close) button of Measure Area dialog disappears if opening it a second time. 

00013382 
The ArcView data server in some cases does not properly serve non-graphic shape files (those with only a .dbf 
file and no .shp file). 

00018278 
00006615 

The Review Attributes command does not properly present attributes from categorized features. 

00030211 The ArcView data server does not properly serve shapefiles that lack attributes. 

00034127 The display of a certain shapefile in GeoMedia results in zingers. 

00054652 
00053206 

Label queries created through the Insert Label command using leader lines do not reposition the label when the 
leader line is edited or moved. 

00053291 Label queries created through the Insert Label command do not update the label when the attribute is edited. 

00053495 
GeoMedia Help incorrectly references an Intergraph folder in the path “C:\Program 
Files(x86)\Intergraph\GeoMedia Professional\” in several different help topics. 

00054859 
The ‘Connection Manager’ dialog of Spatial Modeler fails to open a PostGIS connection when there is partial 
GeoMedia metadata that can be used. 

00054688 
After inserting a new georeferenced image on a machine configured with German regional settings, the Width 
style property for an area legend entry is displayed with a period instead of comma for the decimal separator. 

00020946 
00021243 

No tiles are displayed for a WMTS cite configured with TLS 1.2 only. 
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00015212 The Define Symbol File utility crashes while adding symbols from a MicroStation v8 design file. 

00024330 Keyboard arrow keys on the PostGIS connection properties dialog act as if using the tab key. 

00024492 The Report Warehouse Schema command does not present PostGIS feature classes in alphabetical order. 

00024493 
The Manage Attribute Validation Rules command does not present PostGIS feature classes in alphabetical 
order when building rules. 

00026043 The WMTS data server is unable to display data from an authenticated WMTS service. 

00040532 
The Change Feature Class command with ‘Copy values from matching attributes’ selected sometimes copies 
the wrong value to the target attribute. 

00043682 The WMTS data server fails to honor the ‘Image format’ setting from the Advanced Options dialog. 

00051595 
The Union Features operator fails to preserve Z values from source features in output features if the source 
CRS is not recognized. 

00053240 
The WMTS data server submits the URL with all lower-case characters, causing an authorization failure when 
an access token is required for authentication. 

00046851 
00037350 

The Feature Class Definition command allows definition of an Oracle feature class name with more than 24 
characters for an Oracle 12.2 database, but afterwards GeoMedia can no longer connect to the database. 

00020786 
The Select Set Properties command presents an incorrect picklist value for an attribute when the actual 
attribute value is not in the picklist (due to workflow with the Change Feature Class command). 

00053951 The WMTS data server does not properly read CRS from Supported CRS elements. 

00041031 
00002844 

Buttons disappears when the Database Utilities form is resized. 

00015731 Database Utilities allows insertion of feature class table names that are considered invalid by GDO. 

00059289 
Validate Feature Classes queries for the Advanced Feature Model (AFM) are not correctly updated when a 
spatial filter is defined. 

00058135 Use of an AutoCAD symbol file in a style definition yields an error. 

00059242  
The “Attributes” button on the Query Properties dialog of the Queries command fails to display the Attributes 
dialog for a Union query. 

00034325 
Any change to a picklist value on the Select Set Properties dialog is not saved if the attribute name has a space 
in it through use of the Categories command. 

00060327 
00046851 
00037350 

The Feature Class Definition command allows definition of an Oracle 12.2 feature class name with more than 
24 characters, after which GeoMedia can no longer connect to the database. 

00059184 
00057025 

The WFS data server presents no feature classes when accessing a WFS implementation through a client 
proxy. 

 

Issues Resolved – 16.6 Update 2 
Support Ticket Description 

00056415 GeoMedia PDF export ignores settings for interior boundary tint styles. 

00058202 
00056416 

GeoMedia PDF export ignores dash caps option when custom line type is selected. 

00061856 
The Default Height command does not permit the default height to be set on Windows 10 with a German 
operating system having regional settings using a decimal separator of comma. 

00060839 
The GeoPackage data server is unable to create a feature class with a name having special Norwegian 
characters. 

00062778 
The GeoPackage data server does not properly report the case of non-GDO-compliant database identifiers 
(table and field names). 

00060934 
The WMS data server does not properly handle the case of a WMS implementation requiring authentication 
within layer requests. 

00063704 
The SQL Server capability of Database Utilities throws the error 'Cannot resolve the collation conflict' when 
adding a view-based feature class involving aggregation. 

00012265 
The SQL Server data server GDO) presents the error message “Unable to fetch current record from cursor” 
when deleting. 

00015658 
00005727 

The SQL Server data server displays a message box stating "fetching data and the cursor" in a workflow 
involved a delete. 

00064084 
The Oracle Object Model and Oracle LTT data servers crash in GeoMedia 2020 Update 1 when accessing 
tables without GeoMedia metadata via OriginatingPipe. 
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00017788 
Output to Feature Classes command fails after use Feature Class Definition to rename a SQL Server Spatial 
feature class. 

00065088 
The Edit Feature Class Metadata capability fails in Database Utilities for the GeoMedia-format SQL Server 
warehouse. 

00065230 
00064420 
00064205 
00053446 
00060435 

An edit to a legend entry title results in the refresh of all map windows and a change of the active map window. 

00064855 
00041246  
00052350 
00057363 
00029067 
00057240 
00036160 

The WFS data server shows no feature classes available from the warehouse connection.  [Note: For certain 
WFS implementations it may be necessary to use the new advanced option “Download feature classes and 
process locally”. 

00049171 
00043596 

The WFS data server shows no feature classes available from the warehouse connection when a proxy server 
is used. 

00066302 
00020687 
00068199 

The Attribute Query command fails with an ‘mscorlib’ error under certain circumstances (e.g. when a spatial 
filter is defined). 

00058415  The WFS data server fails to load feature classes after a spatial filter is applied. 

00058852 The WFS data server connection fails a certain CRS configuration/syntax. 

00064269 The delivery of GeoMedia Objects is missing PipeNetwork_tlb.dll and its associated files, 

00065246 
00065261 

The CAD data server has a runtime error when listing available Tags in a CAD Server Schema file for 
MicroStation v8. 

00066344 
00065248 

The GeoMedia Desktop Configuration Wizard is not triggered after installation of GeoMedia Desktop 2020 
Update 1 for any of GeoMedia Viewer, GeoMedia Essentials, or GeoMedia Advantage. 

00066277 
The GeoPackage data server does not honor certain native GeoPackage metadata indicating that a feature 
class should be served without geometry fields. 

00066259 
The SQL Server Spatial data server returns information using the wrong spatial operator, when using a 
snapshot mode recordset. 

00056992 The Batch Plotting utility print capability does not set printer page size correctly for A2, A1, A0. 

00034554 The WFS data server fails to connect, with the error message ‘Cannot find Comparison_Operators element’. 

00065585  
The Validate Features command for Advanced Feature Model has a performance regression in GeoMedia 
2020 Update 1. 

00068104 The GeoPackage data server has memory leaks that affect the scalability of bulk table creation. 

00068326 The SQL Server data servers fail with Insert Feature for tables containing fields that disallow null values. 

00068658 The SQL Server data servers fail when attempting to create text fields with a length greater than 255. 

00068501 
The WMTS data server hangs when using an authenticated service implementation if the user fails to enter 
username and password credentials on the Advanced dialog. 

00065909 The WFS data server hangs when performing an attribute query with an active spatial filter. 

00066994 
The WFS data server fails when connected to a WFS Facade service when using an Attribute Query containing 
more than one OR operator if a spatial filter is defined. 

00069947 The Library Organizer command crashes when copying a Search based on a spatial filter reference feature. 

 

 

Issues Resolved – 16.6 Update 3 
Support Ticket Description 

00067628  
00064849 
00065334 

Display of certain arc geometries generates ghost lines in the layout map graphic. 
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00005295 
00005803 
00005791 

The G/Technology Interoperability Utility errors when processing an area, line, or point feature class when the 
system is configured with German regional settings. 

00009636 
The G/Technology data server is unable to connect to a G/Technology database due to an unregistered Oracle 
DLL. 

00065657 
The Associations command fails to display Properties in read-only mode for Oracle LTT data when no revision 
set is defined. 

00066986 
The Associations command fails with the message “Error accessing features” when a Functional Attributes 
query result is selected as input. 

00068296 
The Associate By Selection command displays a “bookmark” error if the selected features are from a category 
and displayed through a thematic legend entry. 

00068985 
When placing features using the Advanced Feature Model, the expected feature association is not created if a 
point feature is inserted first for the customer database. 

00071229 The Batch Plotting utility produces an error on the second run of an export, when filtering on a query. 

00070354  
00073863 

In an application running with GeoMedia Objects, setting the SpatialFilter property on OriginatingPipe breaks 
the functionality. 

00074046 
The option 'Relative to ticks' for the placement of labels in the Insert Cartographic Grid command is not 
available with the German language pack. 

00071785 
On the Style Properties dialog, when the Advanced tab is active, the dropdown menu for certain style 
properties cannot be opened with the first click when configured with the German language pack. 

00071119 
Installations of Updates for GeoMedia Desktop and its language packs can fail under certain conditions when 
installing on top of a prior update. 

 

 

Issues Resolved – 16.6 Update 4 
Support Ticket Description 

00078183 
When a spatial filter is applied to a PostGIS database lacking GeoMedia metadata the filtering is performed via 
the GeoMedia client rather than the database. 

00074412 
Loading spatially filtered record sets is slower with PostGIS data server when compared to SQL Server Read-
Write (GDO) data server. 

00077418 PostGIS feature load and display times are twice as long as in version 2020. 

00078203 
Output To Feature Classes command ignores the OTTSCommitInterval registry setting, so the default of 500 is 
used regardless of the value specified. 

00077907 OutputToTableService uses an unfiltered query to retrieve metadata. 

00077271 
00082605 

The Delete Features command is very slow beginning with GeoMedia 2020 Update 2. 

00077088 A specific join query loads and displays 6x slower than version 2018 Update 5 when using PostGIS. 

00079060 Insert of JP2 RGBI files crashes GeoMedia Desktop. 

00081208 
00080130 
00079642 

Unable to connect to G/Technology using GeoMedia Desktop 2020 Update 3 when logging is disabled. 

00079675 Output To Feature Classes command with output to Oracle returns ORA-00972 : identifier is too long. 

00080476 Oracle read-write connection crashes when adding long feature names to legend. 

00082434 FSM symbols created with a previous version of GeoMedia are displayed incorrectly in GeoMedia 2020. 

00010004 The append option for Export to AutoCAD fails with no error when exporting points as block references. 
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Issues Resolved – 16.7 
Support Ticket Description 

00021300  
An error related to “G3E_CONFIGURATIONS” is displayed during warehouse connection if the given Oracle 
user/schema is not present 

00039284 If the ribbon bar is minimized, windows cannot be activated via the Window list on the Home ribbon tab. 

00032318 
00012178 

The Measure Distance/Area and Measure Angle commands do not support the Intersection, Tangent, or 
Perpendicular vector snaps. 

00020036 The Copy Feature command does not support the Intersection vector snap. 

00020359 
00017118 
00010307 
00016564  
00010194 
00020248 
00027270 

The window list on the ribbon shows an incorrect list of windows when added to the Quick Access bar. 

00060865 
00060497 
00058875 
00039626 

The Layout Insert Object command fails to insert objects for Microsoft Office documents on Windows 10. 

00033440 
00021266 
00035155 
00037410 
00039662 
00039877 
00040530 
00041780 
00059536 
00059496 

Layout Legend symbology fails to display after using Convert to Graphics command on Windows 10. 

00002084 
00047210 
00044744 
00026293 
00021198 
00005419  

When a JPG file is inserted into the layout window using the Insert Object command, the JPG file does not 
display when the GeoWorkspace is reopened. 

00060750 Connection to a SQL Server database with partial GeoMedia metadata fails in Spatial Model Editor. 

00040051 The orthogonal construction aid snaps to features even though no SmartSnaps are active. 

00027201 The Window List does not work from the Quick Access toolbar unless the Home tab is active. 

00023345 Perpendicular snap does not work for short segments. 

00012378 The ribbon tab Manage Data has a non-operational <Spatial Filter Name> control. 

00020038 
00013393 
00004848 
00045599 

The Edit Geometry command is inconsistent with other data capture commands in its logic for setting the width 
of highlighting for a geometry being edited. 

00062438 The Create Buffer Zone operator fails with French regional settings. 

00063867 
00006205 

When running the Insert Feature command, with AFM enabled for the connection, an error occurs when there 
are closed connections. 

00062225 

The Features Output operator crashes Spatial Model Editor when running a model with the Union Features 
operator, if the ‘features in’ source is direct from an Iterator operator.  [Note: The fix to this problem overcomes 
the crash.  The model still does not run successfully, but it presents the user with a message about the true 
underlying issue which is an unknown CRS.] 

00007378 
00003650  
00010995 
00019637 

Using the Windows list on the Home ribbon tab to change the active window does not work properly when the 
Window group on the ribbon is collapsed. 
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Support Ticket Description 

00004962 
00009261 
00028165  

The 'Window List' command is missing from the Customize Ribbon command dialog. 

00058008  
The Insert Geotagged Images command omits the first character of raster file name if files are stored in a root 
folder (i.e. C:\ or D:\), resulting in a failure to insert the image. 

00064153 Inability to display/assign certain multi-band images to red, green, and blue display. 

00060628 
The Run Spatial Model command crashes if the input given to the Intersect Features operator within the model 
has no feature instances. 

00062429 The Insert GeoTagged Images command fails when a named spatial filter is present in the GeoWorkspace. 

00062161 The Review Geotagged Images command presents an error message after moving the dialog. 

00056382 
The Review Geotagged Images command presents an error when an attached image is present in the map 
window. 

00062160 The Review Geotagged Images command presents an error when hovering over a Graphic Text feature. 

00060137 An inserted IMG raster file results in a black display in the map window. 

00009009 An inserted IMG raster file (8-bit color index) does not display properly in the map window. 

00066962 
The Import File command on the Grid ribbon tab fails to import an IMAGINE-created GeoTIFF file due to a 
difference in the way that void values are specified by the two systems. 

00052917 
The mouse wheel pan capability of the Select Tool does not work on a virtual machine when polygonal 
selection is active in map window. 

00020468 
The Window List control in the Window panel of the Home ribbon tab cannot be used to make the layout 
window active if the Window panel is shrunk to a single button on the ribbon. 

00065164 
For the Features Input operator of Spatial Modeler, a failure to connect occurs when there are various 
metadata errors in the dataset. 

00068232 The Run Spatial Model crashes or outputs incorrect values if the Regional format setting is German (Germany). 

00033555 
The Import ASCII File command fails when using an ArcGrid ASC file with a comma delimiter in the German 
environment and the German language pack installed. 

00062300 The method CanEnable is never called for a custom command created with the new command wizard. 

00062868 The WMTS data server crashes when making a connection to a specific WMTS service. 

00065760 
00055500 

The Label Manager command crashes when copying a legend entry containing persisted label information. 

00068062 
The Toggle Dynamic Labeling command displays a message dialog that must be dismissed each time the view 
changes, if an offset style is defined on any legend entry. 

00034865 
The ‘Temporal Query’ command for Oracle LTT returns an error for the source table named 
CONDITION_HISTORY. 

00019602 The Oracle LTT data server provides incorrect handling of deletions involving foreign keys and parents. 

00036722 
The WMS data server fails to connect to a WMS implementation created by M.App Enterprise that other clients 
can connect to successfully. 

00006976 The right-click menu on for the Customize Ribbon command does not work. 

00018045 Display of circular traffic roundabouts composed of arcs is incorrect at certain display scales. 

00018770 The WMS data server cannot connect to a WMS service with umlauts in the WMS URL. 

00013174 The WMS data server cannot connect to a WMS service due to a "[layer name] is not a valid name" message. 

00014854 
The Customize Ribbon command inconsistently presents command names on the two command lists on its 
dialog. 

00070963 
00077121 

The WMS data server fails to connect to a WMS service instance created from M.App Enterprise. 

00015580 The Review Attributes command does not propertly support review of features from categories. 

00071306 The WMTS data server crashes with a certain dataset. 

00057802 The Update Geometry Z Values on the Grid ribbon tab is very slow with a Geopackage connection. 

00063302 
The Features Input operator in Spatial Model Editor cannot connect to a SQL Server database having a 
Compound feature class with null geometries. 

00070822 
The .tfw file created by the ‘Output to GeoTIFF’ command is using a comma as the decimal separator for the 
coordinates if the regional format is set to use a comma. 
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Support Ticket Description 

00070859 
The startup splash screen does not correctly display diacritic characters that exist within the account name for 
the ‘Licensed To’ entry. 

00063856  
The Features Database Output operator of Spatial Modeler crashes with output to GeoPackage if there is no 
geometry field on the input features. 

00022413 GeoMedia allows insert of unsupported IMAGINE .img format files which are then rendered incorrectly. 

00070859 
The splash screen displayed during application startup does not correctly display diacritic characters that exist 
within the account name for the ‘Licensed To’ entry. 

00074050 
In the Insert Cartographic Grid command, the Offset parameter 'Relative to neatline' has no affect in placement 
when the option 'Rotated with ticks' is set. 

00026117 The Trace command for the Advanced Feature Model fails if the data type of the primary key is Text. 

00009954 The KML data server does not display specific data correctly. 

00040592 
00006559 
00013834 

When invoking the commands Validate Connectivity, Search, Queued Edit, and possibly others, under certain 
circumstances, an Invalid Argument error message is presented. 

00076344 SVG symbol display in the map no longer tolerates an invalid or incomplete symbol definition, 

00076208 
When using the SQL Server data servers, commands that copy attribute values fail to copy values for indexed 
fields. 

00004990 The command Publish To Map creates an invalid KML file and fails to output .png files for some Font Styles. 

00071001 
The command Search fails when searching an Oracle feature class for an attribute defined as an Oracle CLOB 
data type that is mapped to a Memo field in GeoMedia. 

00072861 
Inserts, updates, and deletes are not propertly reflected in GeoWorkspace for a feature class in PostGIS which 
has its primary key defined as UUID, 

00053407 The command Update Attributes truncates values greater than 255 characters when updating a Memo field. 

00076080 Grid import fails to correctly set Z value when importing XYZ or TXT data if values are integer-based. 

00071103 ExportToDesignFileService does not generate linkage types correctly in all cases. 

00077049 
Features Input operator of Spatial Modeler fails to connect to SQL Server if there is no GeoMedia metadata 
and at least one non-dbo owned table or view is present. 

00076281 Features Input operator fails to connect to a certain PostGIS database lacking GeoMedia metadata. 

00074427 The Load Data action on the LegendView control fails to update a legend entry that is in a Display Off state. 

00022540 
The Convert To AFM action of the Feature Model command fails to transfer SFM-defined picklists to AFM-
defined picklists. 

00078060 
When creating a Functional Attributes query the legend entry is incorrect compared to version 2018 and ‘Error 
from query interface for IID_IGMLocatedObejctsCollection’ appears when cursor passes over geometry from 
the query. 

00073268 WMTS data cannot be displayed in a standalone application. 

00070605 Feature Caching fails for certain tables where no primary key is available. 

00063035 
Certain dialogs are displayed with partial text and controls when running on a QHD+ display (3200 x 1800 
display resolution) – Warehouse Connections command, APOLLO Catalog Connection command, Automated 
Validation command. 

00053762  Output to Feature Classes dialog fails to display correctly on high resolution (4K) monitors. 

00049498 
The AFM Picklist dropdown fails to display in a Data Window when the Value field and the Description field are 
the same. 

00044443 
No picklist is available in the Update Attributes command after renaming an attribute using the Categories 
command. 

00034969 Certain dialog buttons and controls are not visible on a 4K HD display for range thematics. 

00033639 
In the Attribute Query command, AFM Picklist values are not copied properly for queries against features in 
categories. 

00002862 In the Attribute Query command, picklist values are not displayed if categories are used. 

00021971 In the Select Set Properties command, AFM Picklists fail to display for a Functional Attributes query. 

00017417 On the Style Properties dialog, the Pattern Fill Style > Point style > Spacing units on the form are incorrect. 

00008544 Legend Entry Properties buttons are missing when monitor text size display is set to greater than 100%. 
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Support Ticket Description 

00011239 
On the Style Properties dialog, when custom text size (DPI) is set to 110% the Advanced tab drop down list 
fails. 

00003649 
00015299 

There is unreadable/truncated text in Label Manager dialog boxes when Display text size (DPI) is greater than 
100%, 

00018199 On the Thematics dialogs, some text is clipped in some forms when Control Panel sizing is not 100%. 

00005050 Export to Shapefile with "Picklist values as descriptions" checked fails to create shape files or log. 

00017032 
In the Move command of the GeoMedia Essentials tier, moving text changes the tentative snap display of the 
text. 

00034962 
Snap locks don't work for the Rotate command when using locked angle and attempting to snap to the base 
point. 

00068652 The ArcView data server has problems serving certain multipolygon geometry from a certain shapefile. 

00077865 The precision defined for a Functional Attribute is ignored on the Select Set Properties dialog. 

00077656  A particular image can’t be inserted as a Geotagged image. 

00066365 
In the Select Set Properties command the column width resets to 20 pixels width when the dialog is 
suppressed or interrupted during startup. 

00077084 For GeoPackage warehouses, INTEGER values greater than 2147483647 are not served correctly. 

00080359 
Invalid empty record sets are created when using certain attribute queries as input to the Aggregation 
command. 

00077840 
Output to Feature Classes command crashes when the target Oracle connection has certain incorrect 
metadata. 

00079675 Output to Feature Classes command returns an Oracle error indicating that an identifier is too long. 

00081522 
GeoPackage data server has problems when geometry is edited a second time through a specific API 
workflow. 

00058124 Unable to open a read-only GeoWorkspace when another GeoWorkspace is already open. 

00036067  Dockable controls that are undocked disappear when the GeoWorkSpace does not have active focus. 

00082509 
The Densify Geometry operator of Spatial Modeler fails with the Dutch (NL) Region format (list separator set to 
semicolon). 

00070770 The Insert Traverse command crashes with a specific workflow. 

00076379 
The Change Feature Class command fails to correctly copy attributes from an AutoNumber field to a matching 
field name of type Long. 

 

 

Issues Resolved – 16.7 Update 1 
Support Ticket Description 

00029072 The Join Features operator fails to run in Spatial Model Editor with a specific model. 

00027261 The MapInfo data server fails to correctly serve MapInfo data containing fields of type LargeInt. 

00023387  
The GPS Tracking command produces incorrect results with German (OS) regional settings when Sensor API 
is used. 

00034952 There is a performance regression in the FGDB data server when adding a legend entry. 

00027323 The color of the linear style definition is wrong when presented in the legend key, under specific conditions. 

00022805 
Export to MapInfo Interchange Format fails to correctly target the output folder if the folder name contains a 
period character. 

00034954 Unable to edit geometry or attributes via Join query. 

00037064 Attributes are not exported on Windows 10 with ExportToAutoCADService in a standalone application. 

00039253 The WMS data server fails to serve the full world extent for WMS version 1.3.0 for EPSG:4326. 

1-U37IUX The LRS Precision Location command can hang for SQL Server Spatial data. 



GeoMedia Desktop 2020 

22 April 2022           43 

Support Ticket Description 

00023030 
The Queued Edit dialog displays the wrong status name in the status field when selecting the QuickStatus 
dialog button. 

00022913 
Dynamic Segmentation queries that use event data attached through the Access data server may fail to load 
when opening GeoWorkspaces. 

00047672 The Capture capability of the Associate Catalog Records command fails for Oracle features. 

00023176 
00023165 

The Properties dialog and Coordinate System dialog fail to open after moving from a multi-monitor 
configuration to a single-monitor system configuration. 

1-KV1NET Secondary point Dynamic Segmentation may fail if a first segmentation query has a single missing segment. 

1-WT8KZ1 A crash occurs when using the mouse wheel to pan and zoom when dynamic labels are displayed. 

00067578 LRS Precision Location readout fails for certain loop geometry conditions. 

1-TURO3D LRS Precision Location command has problem with refreshing the map window. 

00062324 
In Database Utilities, enlarging the Features Properties dialog of Edit Feature Class Metadata causes the 
Picklist Button to move 

00027270 
00027294 

The LRS Precision Location command may not display the expected mapview marker point and measure 
readout for certain data. 

00058672 
The Select Set Properties command takes 60 seconds on a feature with picklists instead of 1 second for the 
same feature previously. 

00058535 The Attribute Query command may get an error outputting a query to the map window for certain data. 

00049249 
Batch Plotting gets an error when selecting/typing standard resolutions using the export functionality with the 
German language pack. 

00056835 Adjustments are needed for text in the Home and Manage Data ribbon tabs in the German language pack. 

00055743 There is missing text in the Home ribbon tab for window commands with the German language pack. 

00055704 
GeoMedia crashes when a spatial filter is used with a Unique Value thematic legend entry and features are 
selected in the map window. 

00053934 Overview & Adjoining maps no longer display correctly when output from Batch Plotting. 

00027332 On the Grid ribbon tab, Study Area panel, Export to XYZ appears to produce incorrect output for some data. 

00023231  
The record count displayed in the Data Window is truncated in German if greater than 5 digits in size.  
(Resolved in the German language pack.) 

00063436  
The Select Set Properties command presents an error “ORA-01000: maximum open cursors exceeded” when 
there are picklists. 
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Contact Us 
 

https://go.hexagongeospatial.com/contact-us-today 

 

 

 

 

 

About Hexagon 

Hexagon is a global leader in digital reality solutions, combining sensor, software and autonomous 
technologies. We are putting data to work to boost efficiency, productivity, quality and safety across 
industrial, manufacturing, infrastructure, public sector, and mobility applications.  

Our technologies are shaping production and people-related ecosystems to become increasingly connected 
and autonomous — ensuring a scalable, sustainable future. 

Hexagon's Safety, Infrastructure & Geospatial division improves the performance, efficiency and resilience of 
vital services. Its Safety & Infrastructure solutions enable smart and safe cities. Its Geospatial software 
leverages the power of location intelligence. 

Hexagon (Nasdaq Stockholm: HEXA B) has approximately 21,000 employees in 50 countries and net sales 
of approximately 3.8bn EUR. Learn more at hexagon.com and follow us @HexagonAB. 
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Copyright  
© 2021 Hexagon AB and/or its subsidiaries and affiliates. All rights reserved. Hexagon has registered 
trademarks in many countries throughout the world. Visit the Trademarks Page 
http://www.hexagongeospatial.com/legal/trademarks for information about the countries in which the 
trademarks are registered. See Product Page and Acknowledgments for more information. 

Product Documentation Terms of Use 
PLEASE READ THESE TERMS CAREFULLY BEFORE USING HEXAGON GEOSPATIAL’S 
DOCUMENTATION ("DOCUMENT"). USE OF THIS DOCUMENT INDICATES ACCEPTANCE OF THIS 
AGREEMENT WITHOUT MODIFICATION. IF YOU DO NOT AGREE TO THE TERMS HEREOF ("TERMS"), 
DO NOT USE THIS DOCUMENT. 

Use Of This Document 
All materials in this Document are copyrighted and any unauthorized use may violate worldwide copyright, 
trademark, and other laws. Subject to the terms of this Agreement, Hexagon Geospatial (a Division of 
Intergraph Corporation) and Intergraph’s subsidiaries ("Intergraph") hereby authorize you to reproduce this 
Document solely for your personal, non-commercial use. In consideration of this authorization, you agree to 
retain all copyright and other proprietary notices contained therein. You may not modify the Materials in any 
way or reproduce or publicly display, perform, or distribute or otherwise use them for any public or 
commercial purpose, except as specifically authorized in a separate agreement with Hexagon Geospatial.  

The foregoing authorization specifically excludes content or material bearing a copyright notice or attribution 
of rights of a third party. Except as expressly provided above, nothing contained herein shall be construed as 
conferring by implication, estoppel or otherwise any license or right under any copyright, patent or trademark 
of Hexagon Geospatial or Intergraph or any third party. 

If you breach any of these Terms, your authorization to use this Document automatically terminates. Upon 
termination, you will immediately destroy any downloaded or printed Materials in your possession or control. 

Disclaimers 
ALL MATERIALS SUPPLIED HEREUNDER ARE PROVIDED "AS IS", WITHOUT WARRANTY OF ANY 
KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED 
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-
INFRINGEMENT. Hexagon Geospatial does not warrant that the content of this Document will be error-free, 
that defects will be corrected, or that any Hexagon Geospatial Website or the services that make Materials 
available are free of viruses or other harmful components. 

Hexagon Geospatial does not warrant the accuracy and completeness of this Document. Hexagon 
Geospatial may make changes to this Document at any time without notice. 

Limitation Of Liability 
IN NO EVENT SHALL HEXAGON GEOSPATIAL BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL OR CONSEQUENTIAL DAMAGES, OR DAMAGES FOR LOSS OF PROFITS, REVENUE, DATA 
OR USE, INCURRED BY YOU OR ANY THIRD PARTY, WHETHER IN AN ACTION IN CONTRACT OR 
TORT, ARISING FROM YOUR ACCESS TO, OR USE OF, THIS DOCUMENT. 

Indemnification 
You agree to defend, indemnify, and hold harmless Hexagon Geospatial, its officers, directors, employees, 
and agents from and against any and all claims, liabilities, damages, losses or expense, including reasonable 
attorneys' fees and costs, arising out of or in any way connected with your access to or use of this Document. 
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Use Of Software 
Use of software described in this Document is subject to the terms of the end user license agreement that 
accompanies the software, if any. You may not download or install any software that is accompanied by or 
includes an end user license agreement unless you have read and accepted the terms of such license 
agreement. Any such software is the copyrighted work of Hexagon Geospatial, Intergraph or its licensors. 
Portions of the user interface copyright 2012- Telerik AD. 

Links To Third Party Websites 
This Document may provide links to third party websites for your convenience and information. Third party 
websites will be governed by their own terms and conditions. Hexagon Geospatial does not endorse 
companies or products to which it links. 

Third party websites are owned and operated by independent parties over which Hexagon Geospatial has no 
control. Hexagon Geospatial shall not have any liability resulting from your use of the third party website. Any 
link you make to or from the third party website will be at your own risk and any information you share with 
the third party website will be subject to the terms of the third party website, including those relating to 
confidentiality, data privacy, and security. 

Trademarks 
The trademarks, logos and service marks ("Marks") displayed in this Document are the property of Hexagon 
Geospatial, Intergraph or other third parties. Users are not permitted to use Marks without the prior written 
consent of Hexagon Geospatial, Intergraph or the third party that owns the Mark. "Intergraph" is a registered 
trademark of Intergraph Corporation in the United States and in other countries. Other brands and product 
names are trademarks of their respective owners. 

Find additional trademark information https://www.hexagongeospatial.com/legal/trademarks. 

Procedure For Making Claims Of Copyright Infringement 
Notifications of claimed copyright infringement should be sent to Hexagon Geospatial by mail at the following 
address: Intergraph Corporation, Attn: Intergraph Legal Department, P.O. Box 240000, Huntsville, Alabama 
35824. 

US Government Restricted Right 
Materials are provided with "RESTRICTED RIGHTS." Use, duplication, or disclosure of Materials by the U.S. 
Government is subject to restrictions as set forth in FAR 52.227-14 and DFARS 252.227-7013 et seq. or 
successor provisions thereto. Use of Materials by the Government constitutes acknowledgment of Hexagon 
Geospatial or Intergraph’s proprietary rights therein. 

International Use 
You may not use or export Materials in violation of U.S. export laws and regulations. Hexagon Geospatial 
makes no representation that Materials are appropriate or available for use in every country, and access to 
them from territories where their content is illegal is prohibited. 

Hexagon Geospatial provides access to Hexagon Geospatial international data and, therefore, may contain 
references or cross references to Hexagon Geospatial products, programs and services that are not 
announced in your country. These references do not imply that Hexagon Geospatial intends to announce 
such products, programs or services in your country. 

The Materials are subject to U.S. export control and economic sanctions laws and regulations and you agree 
to comply strictly with all such laws and regulations. In addition, you represent and warrant that you are not a 
national of, or otherwise located within, a country subject to U.S. economic sanctions (including without 
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limitation Iran, Syria, Sudan, Cuba, and North Korea) and that you are not otherwise prohibited from 
receiving or accessing the Materials under U.S. export control and economic sanctions laws and regulations. 
Hexagon Geospatial makes no representation that the Materials are appropriate or available for use in every 
country, and access to them from territories where their content is illegal is prohibited. All rights to use the 
Materials are granted on condition that such rights are forfeited if you fail to comply with the terms of this 
agreement. 

Revisions 
Hexagon Geospatial reserves the right to revise these Terms at any time. You are responsible for regularly 
reviewing these Terms. Your continued use of this Document after the effective date of such changes 
constitutes your acceptance of and agreement to such changes. 

Applicable Law 
This Document is created and controlled by Hexagon Geospatial in the State of Alabama. As such, the laws 
of the State of Alabama will govern these Terms, without giving effect to any principles of conflicts of law. 
You hereby irrevocably and unconditionally consent to submit to the exclusive jurisdiction of the United 
States District Court for the Northern District of Alabama, Northeastern Division, or the Circuit Court for 
Madison County, Alabama for any litigation arising out of or relating to use of this Document (and agree not 
to commence any litigation relating thereto except in such courts), waive any objection to the laying of venue 
of any such litigation in such Courts and agree not to plead or claim in any such Courts that such litigation 
brought therein has been brought in an inconvenient forum. Some jurisdictions do not allow the exclusions or 
limitations set forth in these Terms. Such exclusions or limitations shall apply in all jurisdictions to the 
maximum extent allowed by applicable law. 

Questions 
Contact us with any questions regarding these Terms. 

 

https://www.hexagongeospatial.com/about-us/our-company/contact-us

